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Thank you for your interest in using PTC software for the 2011-2012 FIRST Competition. This guide 

will help you get started with Windchill 10 PDM/ProjectLink with your FIRST team, as well as, Creo (for 

CAD design) and Mathcad Prime (for engineering calculations). 

Getting started with Windchill ProjectLink 

Congratulations, you have successfully registered your team for a collaboration workspace in Windchill 

10 PDM/ProjectLink.  Whether you are the Project Manager or a team member, you will be able to 

utilize and take advantage of all the capabilities of Windchill 10 PDM/ProjectLink.  Before we begin, it 

would be a good idea to provide an introductory overview of the tool that will be your design 

environment throughout the FIRST competition. 

Note: Windchill ProjectLink is accessed through the Internet. Internet Explorer and Mozilla Firefox are 

supported with Windchill PDM/ProjectLink 10.0.   

 

 

Windchill PDM/ProjectLink is a tool that enables organizations to more easily execute projects, and 

allows effortless collaboration among members of extended FIRST teams.  It facilitates innovation by 

providing a web-based product development platform with all the tools necessary to bring globally 

dispersed design teams together as if working in the same room. 

With Windchill PDM/ProjectLink, it has never been easier to engage the whole FIRST team.  Teams 

are offered the opportunity for faster, smarter robot development that yields better products on time 

and within budget.   

Windchill PDM/ProjectLink provides the proven solution manufacturers need to support product 

development collaboration, and project management and execution during every step of the product 

lifecycle. 

 Simple, easy-to-use interface and light weight visualization enables effective collaboration with 

cross-functional internal teams – as well as suppliers, manufacturing partners, and customers 
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 Powerful collaboration facilitated through discussion forums, automated change notices, 

subscription, notification, and project management tools 

 Connected with Creo, Autodesk Inventor and Solidworks  

 Optimize critical processes such as: product development, collaboration, project management 

and execution 

For more information on Windchill PDM/ProjectLink 10.0, please review the information here.  

 

 

In addition, you can watch videos about Windchill PDM/ProjectLink from the Engineering section. 

http://www.ptc.com/solutions/windchill-10/
http://events.unisfair.com/log_thru.jsp?user=anonymous&pass=anonymous&eid=1049&seid=41
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Roles in your Project 

In your project, there will be two main roles for all team members.  Roles help to group people who 

have similar duties for the team.  The roles are controlled by the Project Manager for your project.  The 

Project Manager is your team leader that registered your team within Windchill PDM/ProjectLink. 10.0   

Here are definitions for the defined roles. 

 Project Manager  

o The Project Manager is the individual responsible for managing the overall project and 

deliverables, ensuring that all project team members have the necessary resources 

required to complete the project, and reporting the status to the rest of the design 

team. It is the Project Manager that would invite all team members to the project. 

 Project Team Members 

o The Project Members are all other users invited to the project by the Project Manager.  

This includes the FIRST team members, industry partners and guests. Only these 

members are able to access the project and are given different access rights and 

roles. 

FIRST Project Content 

Your project has been created with several default folders to inform and support your FIRST team. 

The default folders in your projects are: 

 Designs – This is the main folder that you will save your models and documents to. 
 

 FIRST Resources – This link will direct you to a public library of FIRST resources for your 
team.  Within the library, you will find links to important web sites, kit of parts and the getting 
started page for FIRST.  

 

https://firstrobotics.ptc.com/Windchill-WHC/index.jspx?id=HCHOverview&action=show
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Training Resources 

Project Manager 

As stated above, the Project Manager is the manager of the project.  They are the individuals that 

control the administrative and activity in the project.  Before you can manage the project it is important 

to understand the layout and navigation of your project.  To help understand the layout of the project, 

please review the Layout and Navigation section in the appendix. 

Inviting your team to the Project 

After you have an understanding of the layout in Windchill ProjectLink, it is important to invite your 

team members to the project. 

1. Click Team on the Project tab. The Members page appears. 
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2. In the Members page, make sure you set the Current View to Local Team Roles and 

Member. 

 

3. Beside the role called Team Members, click the Add User Icon .  This will open the Add 

Members dialog. 

 

4. Enter the team members email address in the Email Invitation field, then click Add to move 

the address into the add list. 
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5. Once all the addresses have been added click OK to invite them to the project. 

 

6. An invitation email will be sent to each individual you added, requesting they join the project. 

In the invitation, the users will be provided a link to create an online PTC.com account. Once 

they have successfully created their account corresponding with the email address you used, 

they can access the project. 

 

7. On the Members page, you will see all your team members listed under the assigned role.  

The list will display if they have joined the project or not.  For those that have yet to join, you 

can correspond with them to have them join. 
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Note: If you are inviting other members outside of your FIRST team, you can add them to the Mentors 

role of simple add a new role of your choosing by select the Add Roles icon   from the Team 

table.  

 

8. Click Folder on the Navigator Project tab to return to the project folders. 

Maintain a secure and controlled collaborative design environment 

Only team members invited to a project can access the project, all others would not be aware of the 

project existence.  Even when invited, the Project Manager can manage the security access of the 

project.  Security access can be granted to a folder or a document (including CAD data) that would 

determine what type of capabilities a user can perform on that folder or file.  The security access rights 

are; Full, Read, Download, Modify, Modify Content and Change Permissions. 

If outside sources are invited to a project, the design team can set access rights on certain folder that 

they do not want those sources to see. 

To help understand how to manage security of a folder or document, please review the Managing 

Security section in the appendix. 

Team Members 

To ensure your team can maximize the capability of Windchill ProjectLink for the FIRST competition it 

is good to understand the layout and navigation of your project.  To help understand the layout of the 

project, please review the Layout and Navigation section in the appendix. 

Register for an account 

To access your team’s project, each team member is required to have a ptc.com account (an account 

is linked to an email address).  In the invitation sent from the project manager to join the project, users 

can follow instructions to register for an account.  

 

Alternatively, users can access the following URL to create their user account. 

 http://www.ptc.com/appserver/common/account/student.jsp 

 

  

http://www.ptc.com/appserver/common/account/student.jsp


    
 
 
 

 P a g e  1 0  

Managing Files 

Windchill ProjectLink can manage any type of data you are creating for your design.  You can create 

new folders and add the necessary documents.  These documents will be controlled, indexed with an 

iteration number.   

As documents are checked-out/in a new iterations will be filed.  This enables users to control the 

documents updates and go back to previous iterations if desired.  The iterations will track the date and 

name of the individual who performed the check-in process.  The document history can be observed 

on each documents detail page. 

 

 

Below is a list of short tutorials that will provide an introduction to managing files in ProjectLink. 

 Create Folders 

 Create Document 

 Editing Documents 

 Creating Links 

 Viewing Details 
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Collaborating 

One of the key benefits of Windchill ProjectLink is the ability to collaborate with others on the team, 

regardless of where they are located.  To capture discussions among the team members, users will be 

able to utilize the project discussion forum to post their questions or comments.  This information is 

tracked and maintained for reference, as well as, enabling others users to post replies.  This means of 

communication is vital to a design project versus conventional email, as it tracked throughout the 

design project.   

In addition, team members can schedule design meetings.  These meetings can be scheduled directly 

from Windchill ProjectLink and can include the following information; agenda, meeting location or 

phone number, participants and potential data to be referenced in the meeting.  Emails will be routed 

to the desired team members with instructions on joining the meeting. 

Lastly, team members can route their work to other team members for review.  This capability will 

send emails to the specific team members requesting them to review and provide feedback. 

 

 

Below is a list of short tutorials that will provide an introduction to collaborating with other in Windchill 

ProjectLink. 

 Discussing Projects 

 Discussing Documents 

 Subscribing 

 Routing Documents 

 Create a Meeting 

 Edit Meetings 
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Managing CAD Models 

Besides documents, Windchill PDM/ProjectLink can manage CAD data as well.  This is controlled and 

managed by connecting the CAD application (Creo, Autodesk Inventor or Solidworks) to the project.  

Note: For the 2011-2012 FIRST season, Windchill PDM/ ProjectLink  will support Creo, Inventor 2010 

& 2011 and Solidworks 2011.  

With Creo, PTC has integrated web-connectivity into the design application, allowing seamless 

connection with your project.  Once connected, data will be stored as individual items in your project, 

while Windchill ProjectLink maintains their internal relationships; such as assembly components and 

models used in a drawing.  The critical information stored in the CAD data; such as parameters will be 

indexed and searchable from Windchill ProjectLink. 

Through the connected session of Creo users are able to check-in/check-out CAD data from Windchill 

ProjectLink in order to continue the design or make modifications.  These changes or revisions are 

managed in Windchill ProjectLink, so that users can go back in time and monitor the design evolution 

or start from a past iteration to start a new design.  Team members will be able to observe which team 

member has checked-out the data and its current status. 

Like any document stored in Windchill ProjectLink, team members will be able to perform various 

operations such as; route stored Creo data for review/approval, use the data in a discussion or 

generate an activity. 

Note: To find out how to access the team’s copies of Creo and Mathcad, please review section Start 

with Creo and Mathcad 

 

 

Below is a list of short tutorials that will provide an introduction to managing CAD models in Windchill 

ProjectLink. 
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Registering a Project from Creo 

 Start Creo 

 Click Tools pull-down menu Server Manager.  The Server Manager dialog will display. 

 

 Click the Server menu option from the Server Manager dialog and select Register New 

Server.  The Register New Server dialog will display. 

 

 Enter the following information into the Register New Server dialog. 
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o Name – <Your Own Name> 

o Location - https://firstrobotics.ptc.com/Windchill/ 

 Once you enter the information, click the Check button. 

 

 You will be prompted for your user name and password.  Enter the information and click OK. 

 

 From the Workspace list, choose a workspace from the list of available workspaces.  If you 

are a member of only one team, you should only see one in the list.  If you have more than 

one, choose the workspace corresponding to the desired project.  The name of the project is 

listed under Context.  Click OK. 

https://firstrobotics.ptc.com/Windchill/
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You will notice that the new server has been added to the list of available servers. 
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 Select the new server from the list. 

 

 To set the new server as the primary server, click the Server menu and choose Set as 

Primary Server.  

 

 The new server has been successfully set as the primary server.  Click the Close button to 

close the Server Registry dialog. 

 In the Creo Folder navigator tree, you will notice two new links 

o The new registered server – Windchill Cabinets.   

o The workspace for the registered project.  
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 Now follow the Saving Creo Files to a Project to find out how to save your data on the 

server. 

Saving Creo Files to a Project 

For new models created or opened from your local machine, the following process will outline the 

methods to upload the files. 

 With a model open in Creo, click the File menu and select the Save button to save the model 

to your workspace. 

 

 

 

 Click the Folder Browse tab to show the Folder navigator. 
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 Click on the Workspace link in the Folder Navigator.  

 

 The embedded browser will open and show the contents of the workspace.  

 

 Click the Select All box to select all the items in the workspace.  If you want only a few items, 

select the items individually. 
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 Click the Check-in icon from the table to save the models to the server from the workspace.  

A new Check-In page will be displayed. 

 

 In the Check-in Page, click the Select All box to select all the items that will be checked in.  If 

you want only a few items, select the items individually. 

 

 Click the Choose a Location icon  to choose set the directory the items will be saved to in 

the team’s project.  The Choose a Location dialog will appear. 

 

 From the Set Location dialog, choose the Designs folder from the folder list to save your 

models to.  Click OK to close the dialog. 
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 In the Check-In Page, add a few comments in the comments field.  Click Finish to start the 

check-in process. 

 

 Once the check-in process is complete, you can remove the objects from the workspace if 

they are not needed anymore. 

 

 Click the Select All box to select all the items in the workspace.  If you want only a few items, 

select the items individually. 

 

 Click the Remove icon to delete the objects from the workspace.  The Remove from 

Workspace page appears. 
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 Select all items and click OK from the Remove from Workspace page to remove the objects. 

The Erase Confirm dialog appears.  

 

 Click OK from the Erase Confirm dialog.  This will erase the models from the workspace and 

from the session of Creo. 

 

 Click on the Windchill Cabinets link in the Folder Navigator. 
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 The embedded browser will open and show the contents of your team’s project.  Click on the 

Designs folder to show the uploaded models. 

 

 In the Designs folder you will see all the uploaded files and the created viewable for the files. 
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 Now follow the Retrieving Creo Files from a Project to find out how to retrieve models and 

use the models stored on the server. 
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Retrieving Creo Files from a Project  

 Click File  Open from Creo.  The File Open dialog opens. 

 

 In the File Open dialog, click the Windchill Cabinets folder, then navigate to the Designs 

folder in your project. 

 

 Within the Design folder, select an object you would like to open. Click Open. 
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 The graphics version of models will be retrieved from the server and opened in Creo 

Elements/Pro.   

 

Note: This graphics version allows you to view the models without checking the data out of the 

server.  If you modify anything in the model, you will be prompted to check out the models from 

the server in the Conflicts dialog.  Click OK. 

  

 Click the Folder Browse tab to show the Folder navigator. 
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 Click on the Workspace link in the Folder Navigator.  

 

 The embedded browser will open and show the contents of the project.  You will notice that 

the item you checked out will be shown as checked out with a yellow and black check mark.  

In this example, only the assembly model is checked out, while the parts are not. 

  

Note: In the workspace, the non-checked out models are the graphic versions (read only) models.  

If you indent to edit these models, they are required to be checked out.  

 To check-out the rest of the models of the assembly, click the Select All box to select all the 

items in the workspace.  If you want only a few items, select the items individually. 

 Click the Check-out button from the table to check out the models from the server to the 

workspace.  
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 The Workspace page will update showing all items as checked-out.  This will be reflected in 

the project, indicating that you have checked them out and are working on them.   

 

 Make all the necessary changes in Creo. 

Note: Since the models were check-out from your team project, it is not required to set the folder, 

as they already have a defined folder designated in the project. 

 To check the models back into the project, first save the objects to your workspace.  Since the 

models were opened from the project, they already have a designated location.  Therefore, 

the check-in process can be streamlined. 

 Right click on the checked-out object in the model tree and select Check In > Auto. 
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 This will automatically check in your files to the project.  Erase the models from the workspace 

to keep the workspace clean. 

Viewing the files in your Project 

 Navigate to your team project via https://firstrobotics.ptc.com/Windchill  Access your team 

project. 

 The embedded browser will open and show the contents of your team’s project.  Click on the 

Design folder to show the uploaded models. 

 

 

 

 

 

 Move your mouse over one of the images of a CAD model.  This will open a preview window 

showing the object.  Since the object has been published, you can actually spin the object in 

the preview window.  Clicking on the preview image will open up Creo View Express. 

 

https://firstrobotics.ptc.com/Windchill
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 Click the View Information icon beside a particular object.  The objects information page will 

be displayed. 

 

 

 From the Information page you will notice the number of iterations that have been made to the 

object.  At any time, you can open or check-out any iteration. 

 

Note: At any time, you are having issues or have questions, please send your question to 

firstsupport@ptc.com.  

mailto:firstsupport@ptc.com
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Windchill ProjectLink not only manages Creo data, it also manages other CAD data.  For the FRC 

competition, PTC has provided a plug-in for Autodesk Inventor 2011 and Solidworks 2011 allowing it 

to connect directly with your project.  Like with Creo Elements/Pro, you will be able to check-in/out 

data directly from your project and let Windchill ProjectLink manage the data.  In order to connect 

Autodesk Inventor and/or Solidworks to Windchill ProjectLink, you first have to download the 

Workgroup Manager for Autodesk Inventor and Solidworks (WGM).   

The WGM is located in the Windchill ProjectLink Software Download page.  You will be required to 

accept/decline the license agreement. 

 Installing Windchill CAD Workgroup Managers 

Note: Teams using other CAD applications not available for this season (e.g. Catia, UG-NX, etc) can 

also manage their data in Windchill ProjectLink.  The Work Group Manager for these applications will 

not be provided; therefore, teams should zip their data files and submit these files to the project as a 

document. 

View and Markup  

All CAD data stored in Windchill ProjectLink via the CAD WGM will be published to enable web-based 

viewing.  Team members will be able to visualize the project design without requiring them to have 

Creo Elements/Pro or another CAD application installed. 

Using either the document information page dynamic thumbnail or initiating the embedded viewer, 

users will be able to analyse and interrogate the models.  During the interrogation, users will be able to 

perform operations such as; performing measurements, create sections, create explode states, create 

annotation markups, control model display and review mass properties.  All annotated markups can be 

stored back in to Windchill ProjectLink for future reference. 

 

 

 

https://first.ptc.com/Windchill/netmarkets/jsp/software/list.jsp
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Below is a list of short tutorials that will provide an introduction to viewing CAD models in Windchill 

ProjectLink. 

 Launching and Using Creo View Express  
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Getting started with Creo and Mathcad 

As part of the sponsorship with FIRST, PTC has provided all team members access to Creo and 

Mathcad. 

Creo: 

 

 

Creo is the standard in 3D product design, featuring industry-leading productivity tools that promote 

best practices in design while ensuring compliance with industry and company standards. Integrated 

Creo CAD/CAM/CAE solutions allow you to design faster than ever, while maximizing innovation and 

quality to ultimately create exceptional products. 

Benefits 

 Unsurpassed geometry creation capabilities allow superior product differentiation and 
manufacturability 

 Fully integrated applications allow you to develop everything from concept to manufacturing 
within one application 

 Automatic propagation of design changes to all downstream deliverables allows you to design 
with confidence 

 Complete virtual simulation capabilities enable you to improve product performance and 
exceed product quality goals 

 Automated generation of associative tooling design, assembly instructions, and machine code 
allow for maximum production efficiency 
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Mathcad: 

 

Mathcad drives innovation and offers significant personal and process productivity advantages for 

product development and engineering design projects. Unlike proprietary calculating tools and spread 

sheets, Mathcad lets engineers design and document engineering calculations simultaneously with 

comprehensive applied math functionality and dynamic, unit-aware calculations. 

Benefits 

 Easy to learn and use - no special programming skills required  

 Increases productivity, saving engineers time and reducing errors  

 Improves verification and validation of critical calculations  

 Promotes calculation best practices and reuse of calculation content  

 Complete documentation of calculations supports standards compliance  

Accessing Creo and Mathcad 

 Download Mathcad Prime 1.0 and Creo Elements/Pro 5.0 Schools Edition: 
www.ptc.com/go/softwareforfirst  

 

  

http://www.ptc.com/go/softwareforfirst
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Meeting Platform Requirements for Creo 

Before installing Creo Schools Edition, your computer must meet the requirements in the next two 

tables. For platform details, see http://www.ptc.com/WCMS/files/77552/en/proewf5.pdf 

Operating System Service Pack Processor 

Windows XP Professional and 
Home Edition 32/64-bit 

Base OS, Service Pack 1 and 2 INTEL Pentium/Xeon family or 
AMD Processors 

Windows Vista Business, 
Ultimate, Enterprise 32/64-bit  

Base OS, Service Pack 1, 2 
and 3 

INTEL Pentium/Xeon family or 
AMD Processors 

Windows 7 Professional, 
Ultimate, Enterprise 32/64 bit 

Base OS, Service Pack 1 INTEL Pentium/Xeon family or 
AMD Processors 

 

Platform Minimum Requirement 

Main Memory 512 MB (1 GB or higher) 

Available Disk Space 2,5 GB (Creo)  

Swap Space 500 MB (Recommended 2048 MB or higher) 

CPU Speed Pentium III 700 MHz (Recommended 2.4 GB or higher) 

Graphics Cards 

Cards must support OpenGL. For supported graphics 
cards, see 
http://www.ptc.com/WCMS/files/77552/en/proewf5.pdf 

If your graphics card does not support OpenGL, see the 
section Configuring Graphics Acceleration. 

Browser Microsoft Internet Explorer 6.0 SP1 or later, Mozilla 

Network Microsoft TCP/IP, Ethernet network adapter 

Monitor 
1280 X 1024 (or higher) resolution with 24-bit or greater 
color 

File Systems NTFS 

Mouse Microsoft approved 3-button mouse 

Distribution Media DVD drive 

 

 

 

 

  

http://www.ptc.com/WCMS/files/77552/en/proewf5.pdf
http://www.ptc.com/WCMS/files/77552/en/proewf5.pdf
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Installing Creo Schools Edition 

This edition of Creo is the same edition being used in secondary schools around the world.  In 

addition, this is the same application used by over 50,000 commercial customer globally; including 

Toyota, Motorola, SONY, John Deere, Volkswagen, Hasbro, Nike to name a few. 

For standalone installation, you will be required to install and generate a license for each machine you 

will be installing it on. Please follow the instructions in the installation guide to assist you with the 

installation of Creo. This guide will take you through the step-by-step process of installing Creo 

Elements/Pro Schools Edition. 

 Creo Schools Install Guide 

Installing Mathcad Student Edition 

Like Creo Elements/Pro Schools Edition, the Mathcad Student Edition is a standalone edition.  You will 

be required to install and generate a license for each machine you will be installing it on.  Different 

from Creo, you will be required to obtain a Product Code to successfully install Mathcad.  To obtain 

these codes, please send an email to firstsupport@ptc.com, requesting your team’s product codes. 

Training for Creo Elements/Pro 

PTC has developed two modules to help you in learning the Creo Elements/Pro fundamentals. The 

topics covered in each module will include: 

 User Interface 

 Orientation 

 Part Modeling 

 Assembly Modeling 

 Drafting 

 Rendering 

The second modules build off the experience learned in the first. PTC recommends that you complete 

both modules before you move onto the next task. 

1. Complete the Introductory Primer for Creo Elements/Pro module 

 

2. Complete the Advanced Primer for Creo Elements/Pro module 

http://www.ptc.com/appserver/mkt/educational/program.jsp?&im_dbkey=74432&icg_dbkey=851
mailto:firstsupport@ptc.com?subject=Requesting%20Mathcad%20Product%20Codes
http://ptcschools.com/images/2011_primer.pdf
http://ptcschools.com/images/intro_creo_elementspro.pdf
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Training for Mathcad  

To help get started PTC recommends that you make use of the training materials available under the 

Getting Started tab in Mathcad Prime to familiarize yourself with using Mathcad Prime.  

Click Getting Started Tab > Tutorials 

 

In order to prepare yourself for the use of Mathcad in this Aviation Curriculum, we recommend that you 

explore the Getting Started resources in the following order: 

1. Tutorial 

a. Getting Started Tutorial Exercises (1 – 6) 

b. Solving Tutorial Exercises (1 – 2) 

2. Mathcad Prime 1.0 

a. Operators 

b. Vectors 

c. Units 

d. Integrating with PTC Products 

e. Functions (Optional) 

For additional training on Mathcad, PTC has prepared a number of focused tutorials to assist in your 

learning. 
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 Mathcad Prime Live Scratchpad Module: This tutorial introduces the user to the basics of 

entering and evaluating numerical expressions in Mathcad Prime. Mathcad's unit handling 

capabilities are introduced and explained in brief. (Level = Novice Users, All Ages) 

 Programming with Mathcad Prime Module: This tutorial introduces the user to the basics of 

defining functions and programs in a Mathcad Worksheet. Mathcad¡¦s basic Programming 

capabilities are introduced and applied. (Level = Intermediate Users, All Ages) 

 Better Communication with Mathcad Prime Module: This tutorial presents an extended 

example of using Mathcad Prime to solve a system of linear equations in Algebra 1. Mathcad 

regions such as the Text Box, the Plot Region, and the Math Region are discussed. Users 

learn to use Mathcad Boolean, Evaluation, and Assignment equality symbols. Basic document 

formatting skills are discussed. (Level = Novice Users, Secondary School) 

 Using Mathcad for Parametric Equations: This tutorial introduces the user to using Mathcad 

Prime to model and solve problems involving motion. Mathcad's ability to work with parametric 

equations are emphasized. (Level = Intermediate Users, Secondary School) 

Download the Mathcad Prime 1.0 Primer Tutorials. 

Web-Based Training Portal 

For FIRST teams, PTC has provided free web-based training for Windchill ProjectLink, Creo 

Elements/Pro and Mathcad through PrecisionLMS.  A special site has been created for users to 

access and learn the various applications.   

Teams are required to register to access the portal - Register for the Precision LMS for Schools Portal 

PTC will process your registration and will send an invitation email indicating that you have been 

added to the portal.  Once added, you can access the site from the following link: 

 www.ptc.com/go/plms4schools 
 

 

Enter your username and password and click Login.  This will open the Home Page. 

On the Home Page, select the Find Training tab.  This will allow you to search for given courses. 

http://www.ptc.com/appserver/wcms/standards/fileothumbredirect.jsp?&im_dbkey=132689&im_language=en
http://www.ptc.com/appserver/mkt/educational/program.jsp?&im_dbkey=123873&icg_dbkey=851
http://www.ptc.com/go/plms4schools
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You can search for courses in one of three ways: 

1. Topics: 
Have a question you need answered quickly? Choose Topics to get right to the detailed 
subject you're looking for. 

2. Courses: 
Looking to take a full training course targeted to your job or skill level? Choose Courses to 
search or browse through multiple types of courses including Introduction, Advanced, Role-
Based, etc. 

3. Assessments: 
Looking to test your knowledge or skill? Choose Assessments to search or browse through 
standard and custom assessments 

 

PTC recommends that you complete the following Creo Element/Pro courses.  

 Introduction to Creo Elements/Pro 5.0 - Fundamentals  

 Introduction to Creo Elements/Pro 5.0 - Productivity Tools  
 
PTC recommends that you complete the following Mathcad Prime 1.0 courses.  

 Mathcad Prime 1.0 - Application Orientation  
 
 
Support for FIRST Teams 

Teams can direct their questions to PTC through the support form: 

 www.ptc.com/go/academic-support  

PTC has also established discussion forums for users to post questions and comments.  PTC 

monitors these forums regularly and will promptly respond to your inquire. 

 FRC Forum  

 PTC Schools Edition Forum 

 

  

http://www.ptc.com/go/academic-support
http://www.ptc.com/forums/viewforum.php?f=37&sid=e0b578a016fbb19fa01cb7adb753ebff
http://www.ptc.com/forums/viewforum.php?f=33
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Appendix 

Layout and Navigation 

 

The Home Tab Options 

Upon successfully logging on to Windchill ProjectLink, users have access to Home and Project tabs. 

Administrators may access other tabs that correspond to organization and system level capabilities. 

Note: The screens capture the interface and navigation experience for a team member who is not an 

administrator.  

 

From the Home Main page, the following pages are available:  

 Overview - Provides a snapshot of the information customized and relevant to the logged on 
user at that current time. This page consists of several table views.  

 My Tasks - Provides a view of all objects for which you are responsible, either as an owner, 
an assignee, or as a resource, and a list of available actions that can be performed on the 
item. The My Tasks table on the home page displays work objects for which you are 
responsible, either as an owner or assignee. This table is meant to be a quick reference of 
your assignments and may not be comprehensive. The Tasks tables available on the context-
specific Tasks pages may contain all tasks in the context, not only the ones for which you are 
responsible. The view you choose on the table constrains the tasks you see.  

 Updates - Provides a view of all objects that you have recently created or modified, and a list 
of available actions that can be performed on the item. 

 Subscriptions - Provides a list and interface to various object subscriptions. Subscribing to 
an object means the user receives an e-mail notification when certain events or actions affect 
that object. For example, such an event occurs when a document is checked in or the status 
of a milestone changes.  

 Reports - Displays a report table that allows a variety of reports to be run across projects in 
which users participate. Only items for which the logged in user is the owner display in the 
results.  

 Checked-Out Work - Provides a list of all objects such as parts and documents that you 
currently have checked out, and a list of available actions that can be performed on the item.  

javascript:openReaderForCourse(35)
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 My Workspaces - Provides a list of any workspace created to exchange CAD data with its 
native application. If CAD data has not been used, the Workspaces option may not appear.  

 My Meetings - Displays the meetings across all projects to which users received invitations or 
created.  

 

You can customize what tables to appear on the Home Main Page by clicking on the Customize 

button in the right side of the page. From here you can selelect the tables by checking and 

unchecking the boxes in front of them. 

 

The Navigator allows you to find and browse for files stored in Windchill. The Navigator contains two 
tabs: the Browse tab and the Search tab. The Browse tab allows you to navigate to various contexts 
you have access to, such as your Projects or Products. The Browse tab also contains Recently Visited 

, which displays your recently accessed contexts and workspaces. The Search tab allows you to 
search for objects in Windchill by entering your own advanced search parameters, or by using a saved 
or historic search.  
Click anywhere on the Navigator bar to expand or collapse it. Click Search or Browse to open the 
Navigator to that tab.  

 

 

We will investigate the Software Downloads, option under the Quick Links button. Several important 

visualization and enabling software components are installed from this area.  

https://firstrobotics.ptc.com/Windchill-WHC/NavBrowseAbout.html#NavBrowseAbout_NavBrowseAbout-765E638133_11
https://firstrobotics.ptc.com/Windchill-WHC/NavSearchAbout.html#NavSearchAbout_NavSearchAbout-765E724A33_13
https://firstrobotics.ptc.com/Windchill-WHC/NavBrowseAbout.html#NavBrowseAbout_NavBrowseAbout-765E638133_11
https://firstrobotics.ptc.com/Windchill-WHC/NavBrowseAbout.html#NavBrowseAbout_NavBrowseAbout-765E638133_11
https://firstrobotics.ptc.com/Windchill-WHC/NavRecentContextAbout.html#NavRecentContextAbout_NavRecentContextAbout-78E9287733_19
https://firstrobotics.ptc.com/Windchill-WHC/NavSearchAbout.html#NavSearchAbout_NavSearchAbout-765E724A33_13
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Downloadable Software Components 

From the Quick Links tab, select the Software Downloads page link to download any plug-ins 

necessary for additional functionality, such as:  

 Plug-ins for CAD systems to upload CAD files  

 Heavy visualization tool to observe viewable files and perform extensive visual collaboration  

 Microsoft Project  Integration  

 Windchill Desktop Integration  
 

Accept the terms of the License Agreement to proceed on to the subsequent screens.  

A section of the Software Downloads page is presented below. The selections available to you as a 

user are governed by PTC’s agreement with FIRST.  

 

When you select a linked item, the system initiates the installation process associated with that 

software component.  
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Tutorial and Online Help Access 

The section of the Windchill page, shown below, displays various options, under the buttons Quick 

Links->Help  

 

 

The following options, available in any context, provide the following functionality:  

 Event Management - utility provides a way for you to check and act on log messages 
generated in your authoring application or Windchill sessions. 

 Clipboard – Allows a user to view items saved to the clipboard. 

 Help - Provides definitions and detailed information on the functionality of Windchill.  

 E-mail Page - Allows a user to e-mail a link to the page they are currently viewing, along with 
comments to desired recipients.  

 Notebook - The notebook is a way to organize your information. You can use the Notebook 
and My Notebook tables to upload files into Windchill, create links, and organize your 
information into folders and subfolders. 

 Copy Page - Allows the ability to paste the current URL to the clipboard for easy creation of 
links to the selected value.  

 WVS Job Monitor - allows you to view the status of different types of WVS jobs. The Job 
Monitor can be accessed from various locations in Windchill by clicking on the WVS Job 

Monitor icon , or from the Business Administration section of the Utilities page. 

 Copy Page - Allows the ability to paste the current URL to the clipboard for easy creation of 
links to the selected value.  

 Search - Provides high-level search functionality. For details, refer to the tutorial titled 
"Searching Projects."  

 My Settings - Allows the ability personalise your Preferences, Profile, Calendar  
 

 

 Preferences - allows users to view and set preferences, such as display and search options, 
to enhance their Windchill experience, and allows administrators to view and set preferences 
for various application contexts, such as projects, products, or organizations. 

 Profile - The team member details page is accessible by clicking the view information icon 
from the Members table for a particular context. The page displays details about an individual 
team member. 

 Calendar – From this page you can personalise your Calendar 
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The Project Tab Options 

In addition to a Home page, all users have access to a Project tab, as shown below. The Project page 

is the primary area for project collaboration and execution functionality. To access the Project page 

you have to expand the Navigator. 

 

After the Navigator was expand, you have to click on Recent Projects icon, and then the following 

options will appear to access you project, like in the screenshot below. 

 

The following options are available under the Project tab:  

 Projects List - Displays the projects with which the user is currently involved, either as the 
project manager or as a team member (participant).  

 Details - Displays the information specific to a particular project such as the budget, start 

date, status, and estimated finish date. (Action Tab  - 
Information pages contain a list of applicable actions in a menu just below the object 
identification line) 

 Folders - Provides access to information about a specific project, including folders, 
documents, parts, CAD documents, and links. This is the central repository for objects and 
files relevant to the project.  
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 Workspaces - Allows transferring and interoperability with CAD data and its native 
application. This tab is only available when CAD data is used within a project.  

 Plan - Displays information about the activities, summaries, sub projects, and milestones 
associated with the current project. An overall project timeline is displayed for a quick project 
status check view and overall progress snapshot.  

 Team - A project team is a list of the members of a particular project. If the user is the project 
manager for a project, the team can be modified from this page.  

 Resources - Resources are necessary to the completion of the project or program, such as a 
person, facility, piece of equipment, or particular material. They normally have cost, time, or 
technical restraints associated with them, and can be tracked as part of the budget by 
associating resources with activities and milestones. Resources may be physical (plants, work 
centers, tooling, process materials) or represent a specific skill. 

 Meetings - Windchill meetings allow you to schedule conferences with team members and 
displays all meetings created in the current project.  

 Tasks - Displays work objects for which you are responsible, either as an owner or assignee. 
Displays all resolved and unresolved action items, completed and uncompleted deliverables, 
activities, summary activities, tasks, and project management tasks.  

 Discussions - Allows the user to start discussions about certain topics that relate specifically 
to the active project.  

 Reports - Displays a report table that allows the user to run predefined conditional reports on 
the current project.  

 

Display Filtering and User Preferences Capabilities 

Display configuration and list filtering options reside throughout the Windchill interface areas. The 

Current View drop down list is displayed on almost every main page, and aids in focusing on specific 

work.  

 

Other general interface capabilities available in Windchill include wizards that are often used in multi-

step operations, and object action lists which are initiated by selecting the Actions link or by choosing 

items from the object drop-down action list.  

Managing Security 

Managing security to projects and documents is an important feature that Windchill provides. 

Managing security is easy to accomplish and allows you to manage the way in which project members 

including members in offices around the world handle a project. Managing security is critical to 

ensuring the integrity of your business data. 

Navigating to the Folder Actions Drop-down Menu 

Managing security settings are specified for the groups affiliated with a selected object in your project.  

1. Click the Actions option folder tab.  This will expand the Folder Actions Drop-down Menu or 
right mouse click in the context of the project.  Select the Manage Security option. 
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Displaying Participants 

The initial list of participants displayed in the table is determined by the view drop-down list selection 

that is active when you open the window containing the table:  

 

 My Access -- Populates the table with you as a participant and displays your access control 
information. 

 Team Access -- Populates the table with the groups containing the team members of the 
current context and displays the associated permissions for each participant. This view is 
useful when you want to change the permissions for those members in one or more team 
roles. The view shows the system groups associated with team membership. These groups 
include the following:  

o A group for each role included in the team. For example, the Members group (used for 
users who need general access to all actions in the context), the Guest group (user-
defined groups and users that are not active team members and need only read 
access to context information), and corresponding groups for the other team roles. 

o The Team Members group, which contains all participants in the team excluding those 
members in the Guest role. 

The participants can be users, groups, or organizations. 

 All Defined Access -- Populates the table with the users, groups for which access control 
permissions have been defined and displays the associated permissions for each participant. 
This view is useful when you want to view all participants who currently have access control 
permissions defined for a single object. The participants listed are those who are actually 
named in either a policy access control rule or in an ad hoc access control rule. If a dynamic 
role is used as a participant in defining policy rules, the system group containing the team 
members of the role for the current context is listed as the participant rather than the dynamic 
role. By default, the All Defined Access view groups the Access table by the Applies To 
column. A policy access control rule can either apply to the participant listed or all users 
except the listed participant. For more information about rules applying to all users except the 
selected participant, see Selecting All Except Principal. 

The identity information displayed in the Participant column is dependent on the Detailed 

Participant Identification preference in the Security category. By default a simple format is 

used. If you change the default setting, additional information is displayed to help distinguish 

participants with the same name. For more information, see Setting Security Preferences.  

Access Control Types 

Before we set access controls, let's define access control types for an understanding of what the 

controls mean to your project members.  

https://firstrobotics.ptc.com/Windchill-WHC/SecurityMgmtParticipantRef.html#SecurityMgmtParticipantRef_SecurityMgmtParticipantRef268_14
https://firstrobotics.ptc.com/Windchill-WHC/SecurityMgmtPolicyRuleRef.html#SecurityMgmtPolicyRuleRef_SecurityMgmtPolicyRuleRef270_50
https://firstrobotics.ptc.com/Windchill-WHC/SecurityMgmtAdHocRuleRef.html#SecurityMgmtAdHocRuleRef_SecurityMgmtAdHocRuleRef270_51
https://firstrobotics.ptc.com/Windchill-WHC/PolicyAdminAllExceptPrincipalSelect.html
https://firstrobotics.ptc.com/Windchill-WHC/SecurityMgmtPreferencesSet.html#SecurityMgmtPreferencesSet_SecurityMgmtPreferencesSet269_63
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 Full Control (All) - A participant (user, group, or organization) granted the Full Control (All) 
permission is granted all permissions currently defined and any defined in the future. 
Therefore, if new permission types are defined, you do not have to write rules that specifically 
grant them to participants with full control access. 

 Read - The right to know the existence of an object and to view the object and its attributes. 
Additionally, if the object has content, you can view an object's content information such as 
the file path to a local file or the location of external storage. This permission does not allow 
you to view the actual contents of the file. 

 Download - The right to download local files that are the primary content or are attachments 
of an object. This right is applicable to objects with content, such as documents or drawings. 

 Modify - The right to change the attributes of an object, as well as other characteristics that 
are part of the object definition but are not controlled by the Modify Content or Modify Identity 
permissions.  For versioned objects, a user must have the Modify permission on the latest 
iteration of each version of a target object to update the attributes common to all versions that 
are not part of the object’s identity. Modify permission on a version of a target object is 
required to modify that version’s attributes. 

 Modify Content - The right to modify any local file, URL, or external storage for the primary 
content and attachments of an object with content. This includes modifying content information 
and adding, replacing, or deleting content. 

 Change Permissions - The right to change the ad hoc permissions that others have. Users, 
groups, or organizations granted the Change Permissions permission are allowed to change 
the ad hoc permissions of others to the permissions they themselves have or to a subset of 
the permissions they have. 

 

Setting Security Access 

When you have displayed the Manage Security menu, you can set the controls for your project 

groups.  

1. Select the desired Access – Team Access in this case. 
 

 
 
 

2. Select the desired options for the appropriate groups.  
3. Click OK. Access controls are set and the Manage Security menu closes.  

For folders only: You can select Propagate Access Control Changes to all folder contents. However, 

the access control of any items in the folder that are currently checked out will not change.  
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Create Folders 

In Windchill, folders are created in projects to display related documents, CAD documents, parts, and 

links. 

Accessing Create Folder Icon 

The first action you need to take in order to create a folder is to navigate to the Create Folder icon on 

the Folders page or right click with the mouse button in the context of the project like in the 

screenshot below.  

 

 

Let's navigate to the Create Folder icon. 

1. Click Folders and check the box next to the folder you want to create the folder in.  
2. Click Create Folder icon. The Create Folder page appears. 
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Populating Create Folder Fields 

On the Create Folder page, you name the folder, define the location, and set the security controls for 

the project members. Let's define folder details.  

1. Type Robot Design in the Name field. Click Next. 

 

2. Set the appropriate security access for the various project members.  

 

3. Click Finish to complete the creation of the project folder. You may also click Apply to 
complete this folder and continue to create another one.  

Note: the All Members group is a pre-defined container of all team members and allows global 

management of access control with a project.  
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Rename a Folder 

If you want to rename a folder, just right click with your mouse button over the desired folder and 
select the Edit option: 

 

In the Edit window, you can change the name and the description of the folder. After you have made 

all the modifications you can click on the OK button to propagate the changes. 

 

 

 

Create Document 

Windchill PDM/ProjectLink allows you to create documents by uploading files from your existing local 

directories. 
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Accessing Create Document Icon 

The first action to create a document is to open the Create Document wizard, by clicking on the New 

Document icon   or accessing the Actions Folder Ribbon -> New->New Document 

 

1. Click Create Document icon  on the Folder page toolbar.  
 

 

 

 



    
 
 
 

 P a g e  5 2  

Creating a Document for a Specific Location 

We will create a file to the Robot Design folder in your project. With the Create Document wizard 

open, follow these steps:  

1. Determine the new document Type from the pull-down list.  This sets the classification for the 
file. Choose Document then click Next. 

 

 

2. Click Browse and search for the document you want created in the selected folder.   
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Tip: If you would like to lock the document for editing after you have created it, check the Keep 
checked out after checkin checkbox or the Check out and download checkbox if you have created the 
document from a template.  

 
3. Type a name in the Name field, in the Attributes Section.  
4. Type a Description.  
5. Specify a location. The location confirms the folder to which the file uploads.  
6. If you click Next and not Finish button, you will access the Set Attachments page. You can 

attach content to a selection of Windchill objects, including documents, change objects, and 
notes. Attachments can be a local file, a URL link, or an externally stored source of content. 
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Attachment Type - Description 

 Local File - attachments are files that you upload from your local machine to Windchill. For 

example, this can be a Microsoft Word document, a text file, or a graphic.  

 URL - URL attachments are hyperlinks to content stored on a website outside of Windchill. For 

example, this can be a wiki page or product help site.  

 Externally Stored Content - External content attachments are items that cannot be attached as 

local files or URL links because they are physical objects or places.  
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For example, this can be a three-dimensional item such as a product model or prototype, or highly 

sensitive data stored in a secure location. An externally stored content attachment describes the 

content and refers the user to its location. 

7. Click Finish.  
 

Editing Documents 

Users frequently need to edit documents contained in a project to capture changes and iteration 
history, while preventing other project team members from overwriting their changes. You can right 
click with your mouse button on the document you want to Edit and the Actions List for the 
managing the document will appear. 
 

 
 
 

Folder Content Actions 
 

Icon Action Description 

 

Add to ▶ Add to 

Baseline 

Opens the Add to Baseline window, allowing you to add the most recent 
version of the object to a baseline. A baseline is a snapshot of an evolving 
collection of product data objects. You can search for an existing baseline 
or create a new baseline in which to include the object. For more 
information, see About Managed Baselines.  
Note This action is available only for products or libraries.  

 

Add to ▶ Add to 

Hot Links 

Add a link for each selected row to the Hot Links folder in the Notebook 
under the Home tab.  

https://firstrobotics.ptc.com/Windchill-WHC/BaselineAbout.html#BaselineAbout_pubsConcept117_45


    
 
 
 

 P a g e  5 6  

 

Add to ▶ Add to 

Managed 
Collection 

Opens the Add to Managed Collection window, allowing you do add the 
object to a managed collection. Note that a managed collection cannot 
contain a package but a package can contain a managed collection. For 
more information, see About Managed Collections.  

 

Add to ▶ Add to 

Workspace 

Opens the Add to Workspace window, allowing you to add the selected 
object to a specified workspace. For more information, see Workspace 
Page Functionality.  

 

Check In Opens the check-in window for the object, allowing you to check in the 
object that you have checked out. The check-in operation saves the 
modifications you have made to the object in the system and also iterates 
the object, for example, from A.1 to A.2. For more information, see 
Checking In an Object.  

 

Check Out Checks out the object to you, locking it to prevent modification by others. 
You can then undo the checkout or check in the modifications you have 
made to the object. For more information, see Checking Out an Object 

 

Check out to 
workspace 

Opens the Check Out and Add to Workspace page, allowing you to collect 
and configure an entire set of objects for checkout. For more information, 
see Checking Out Objects from the Workspace.  

 

Compare ▶ 
Compare 
Information 

Allows you to select a different object of the same type and compares the 
object information. 

 Compare to CAD 
Structure 

Opens a window where you select a CAD structure with which to compare 
the selected part and its structure. 

 

Compare to Part 
Structure 

Opens a window where you select a part structure with which to compare 
the selected part and its structure. For more information, see Comparing 
Structures.  

N/A Convert To PDM 
Check Out 

Check out to a project an object that is currently shared to that project 
from a product or library. 
Note 

This action is available only for products and libraries.  

 

Copy Places a copy of the selected object on the Windchill clipboard so that it 
may be pasted elsewhere as a new object or a reference. For more 
information, see About Copying an Object.  
Note To perform this action, you must select the check box for each object 

that you want to copy.  

 

Cut Move objects to the Windchill clipboard temporarily, until transferred to 
another location within a context using the paste action. Objects are 
permanently removed from their original locations when the paste action is 
complete.  

 

Delete Opens the Delete window, allowing you to remove the object and related 
objects from the database. For more information, see About Delete.  

 

Download 
Documents to 
Compressed File 

Create and download a compressed file (ZIP) containing selected 
documents and folders. Both document content and the folder structure 
are added to the compressed file.  

N/A Edit Multiple 
Objects 

Edit multiple documents at once. For more information, see Editing 
Multiple Documents.  

 

Export Opens the Export window, allowing you to compress the content and 
metadata of the object into a JAR file in order to move the information to 
another site or portal. The JAR file resides on your local file system prior 
to being moved. For more information, see About Export and Import.  

N/A Export List to File Export the information in the Folders table to a file that can be accessed 
offline in programs such as Microsoft Excel. You can export this list in 
CSV, HTML, TEXT, XLS, XLSX, XLS Report, or XML format.  
Once you have selected a format, a window will open, showing the 

https://firstrobotics.ptc.com/Windchill-WHC/MgdCollectionAbout.html
https://firstrobotics.ptc.com/Windchill-WHC/CADxSrvrWspOviewWspPageFunct.html
https://firstrobotics.ptc.com/Windchill-WHC/CADxSrvrWspOviewWspPageFunct.html
https://firstrobotics.ptc.com/Windchill-WHC/CommonObjCheckIn.html#CommonObjCheckIn_CommonObjCheckIn117_118
https://firstrobotics.ptc.com/Windchill-WHC/CommonObjCheckOut.html#CommonObjCheckOut_CommonObjCheckOut117_127
https://firstrobotics.ptc.com/Windchill-WHC/ProEWCIntegGWObjCheckOutFromWsp.html
https://firstrobotics.ptc.com/Windchill-WHC/PMStructureCompare.html
https://firstrobotics.ptc.com/Windchill-WHC/PMStructureCompare.html
https://firstrobotics.ptc.com/Windchill-WHC/InteropItemCopyAbout.html
https://firstrobotics.ptc.com/Windchill-WHC/CommonDeleteAbout.html#CommonDeleteAbout_pubsConcept117_203
https://firstrobotics.ptc.com/Windchill-WHC/DocMgmtMultipleDocEdit.html#DocMgmtMultipleDocEdit_DocMgmtMultipleDocEdit117_221
https://firstrobotics.ptc.com/Windchill-WHC/DocMgmtMultipleDocEdit.html#DocMgmtMultipleDocEdit_DocMgmtMultipleDocEdit117_221
https://firstrobotics.ptc.com/Windchill-WHC/ExportImportAbout.html
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progress of the file. When the export is complete, the file will either 

automatically open in your browser, or a window will appear allowing you 

to choose whether to open or save the file. This depends on your browser 

settings.  

N/A Manage Security Opens the Manage Security window from which you can view the current 
permissions on the object for any user, group, or organization that you can 
access. If you have the required permissions, you can change the current 
ad hoc access control permissions that are in place for the object. For 
more information, see Access Table.  
If security labels are enabled for your site, clicking the Security Labels tab 

allows you to view and set the security label values for each label defined 

for the object. For more information, see Security Labels Table.  

Note To modify security for a specific object, select the action from that 

object's right-click actions menu or select the object in the folder browser 

and use the table-level action. Using the table-level action without 

selecting an object modifies the permissions of the folder selected in the 

Folders table.  

 

Move Opens the Move window, allowing you to transfer all versions of a 
selected object, and other related objects to another context and folder 
location. For more information, see About Move.  

 

New ▶ New 

Document 

Create a new document in the folder. For more information on documents, 
see About Document Management.  

 

New ▶ New 

Document from 
Template 

Create a new document based on a template that provides a standard 
format. For example, your administrator can create a template for meeting 
minutes or specifications.  

 

New ▶ New 

Folder 

Place a new folder in the table or within another folder. The folder appears 
at the top of the list, or if you select the check box next to the folder name 
before clicking New Folder, the new folder appears above the selected 
folder.  

 

New ▶ New Link Create a link in the folder to an object that resides in another location. 

 

New ▶ New 

Managed 
Collection 

Creates a collection of objects that can be used to gather related objects 
into a cohesive set for inclusion in a package or to be routed for review or 
approval. For more information, see About Managed Collections.  

 

New ▶ New 

Multiple 
Documents 

Create several documents at once, rather than creating one document at 
a time. The documents must contain primary content from local files and 
must all be created in the current context.  

 

New ▶ New 

Multiple Parts 

Create several parts at once, rather than creating one new part at a time. 
Is action is available in Windchill PDMLink and Windchill ProjectLink only.  

 

New Note Create a new note in the folder. 

 

New ▶ New Note 

from Template 

Select a note template that provides standard format for notes. 

 

New ▶ New Part Create a part in the folder. This action is available in Windchill PDMLink 
and Windchill ProjectLink only. 

 

Paste Transfer the last objects cut or copied to the Windchill clipboard into the 
selected folder. 
Note Before pasting copied objects, you must select the check box of the 

folder into which you want to paste the objects.  

 

Route (Windchill ProjectLink only) Opens the Route window, allowing you to 
move an object through an automated process, such as a review or 
approval routing. For more information, see Routing an Object.  

 

Save As Opens the Save As window, allowing you to create a new object based on 

https://firstrobotics.ptc.com/Windchill-WHC/SecurityMgmtAccessTableRef.html
https://firstrobotics.ptc.com/Windchill-WHC/SecurityLabelSLTableRef.html
https://firstrobotics.ptc.com/Windchill-WHC/CommonMoveAbout.html#CommonMoveAbout_pubsConcept117_266
https://firstrobotics.ptc.com/Windchill-WHC/DocMgmtAbout.html#DocMgmtAbout_DocMgmtAbout89_7
https://firstrobotics.ptc.com/Windchill-WHC/mgdcollection/MgdCollectionAbout.dita
https://firstrobotics.ptc.com/Windchill-WHC/ProjMgmtRouteCreate.html
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the current object. The attributes and relationships that can be carried 
forward to the new object vary by object type.  
Note This action is available only for parts, documents, and CAD 

documents.  

 

Send to PDM Opens the Send to PDM window, allowing you to check in the current 
object and related objects from a project to a product or library. For more 
information, see Sending Objects to PDM.  

 

Set State Opens the Set State window, allowing you to change the life cycle state of 
the object, for example, from In Work to Released. For more information, 
see Setting the State of an Object.  

 

Subscribe Opens the Subscribe window, allowing you to subscribe to certain events. 
For more information, see Subscribing.  

 

Undo Check Out Releases your hold on the object, making it available for others to check 
out. Modifications you made to the object are not maintained. For more 
information, see Undoing a Checkout.  

 

Undo PDM 
Checkout 

Undoing a PDM checkout reverses the check-out operation on an object 
from PDM to a project. Modifications you made to the object are not 
maintained. For more information, see Undoing a PDM Checkout.  

 

Update Project Update any object shared to the project. This allows the most recent 
iteration of the object to be downloaded from the project to a user's 
workspace.   

 

Upload 
Documents from 
Compressed File 

Add documents and folders to Windchill from files and folders contained in 
a compressed file (ZIP or JAR). For more information, access the online 
help available from the Upload Documents from Compressed File window.   

 
Checking out Documents 

To edit a document, you must first check it out to prevent others from making simultaneous, overriding 

changes.  

There are three checkout options, Check Out and Download, Check Out and Edit and Check Out, 

which are available from the Actions list for the document.  

 Use the Check Out and Edit option for immediate editing work.  

 Use the Check Out and Download option to store the file on your system to perform editing 
work. 

 If you are going to edit the file later, but you want to prevent others from locking out the 
document, choose Check Out.  

Note: If you do not see these options or the pencil icon, it means that you do not have write access to 

edit files.  

 

https://firstrobotics.ptc.com/Windchill-WHC/InteropObjectCheckInToPDMSystem.html
https://firstrobotics.ptc.com/Windchill-WHC/CommonItemStateSet.html#CommonItemStateSet_pubsTask117_560
https://firstrobotics.ptc.com/Windchill-WHC/Subscribe.html#Subscribe_Subscribe117_570
https://firstrobotics.ptc.com/Windchill-WHC/CommonObjCheckoutUndo.html#CommonObjCheckoutUndo_CommonObjCheckoutUndo117_579
https://firstrobotics.ptc.com/Windchill-WHC/InteropObjectUndoCheckOut.html
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In this example, a Check Out and Edit is performed. This accomplishes the following tasks:  

1. Check out the document so that no other project team member can modify and upload it.  
2. Visually mark the document with a red checkmark icon to denote its checked out status.  
3. Download the document file to the user's temporary computer directory area.  
4. Open the file in the document's native application, ready for editing.  
 

During the download process, you may see the following prompt:  

 

In this example, Cancel was selected. Once the document opens in its native application (in this case, 

Microsoft Word) and changes are made, choose Save and a select a new storage location to place the 

modified file on the disk.  
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Checking Edited Documents back into the Project 

When a document is checked out , it appears as shown in the screenshot below, for all project team 

members. In this example, the document is titled FIRSTROBOTICS WC 10 QUICK START Guide.  

 

Now we'll check the document back into the project.  

1. Select the Actions link for the document or right click on the document that you want to 
check in. The Document Actions pull-down menu displays. Note that Check In is an 
available option. Undo Checkout is also available, which can be used to unlock a file for other 
users to edit. In this example, we'll use Check In.  
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2. Select Check In from the Document Actions pull-down menu to display the Check In dialog 
box, shown in the graphic below. Click Browse and select the file that was just saved to disk. 
This file appears in the File to Upload box. You can also enter any relevant comments to 
associate with this iteration in the Comments area.  
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3. Click OK. The document now appears without the yellow checkmark. All team members have 
access to the latest version of the document, and the Last Modified Date column displays the 
new time stamp, as shown in the graphic below.  

 

Displaying the Iteration History 

You can access new and older versions of a document using the Iteration History table.  

Navigate to the Information page for the document. To do this, you can either select the details icon

 next to the document name in the Folders table or choose View Information from the Actions 

menu for the document and next select the History Tab.  

The iteration history is shown in the graphic below.  
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How to move a file to another folder 

 

In this scenario, the FIRSTROBOTICS WC 10 Quick Start Guide will be moved from the Robot 
Design folder to the Documents folder. This procedure is applicable for CAD documents also. 

1. Access the Robot Design folder and select the document to be moved. Then click on the 

Actions button and select the Cut option. 

 
 

2. Then after you will see a confirmation message at the top of your browser. Then you can go to 

the Documents folder and Paste the document there by selecting Actions->Paste option. 
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Creating Links 

Links are objects that can be created and maintained within the file infrastructure of the Folders page. 

Links can be created and maintained within the file infrastructure of the Folders page.  

Link Creation 

To create a new link, use either the Create Link option available from the Actions linked list at the 

folder tabs level, like in the screenshot below.  

 

The Create Link wizard appears.  
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The Create Link Wizard 

The image below shows the fields presented when creating a link:  

 

Enter the following information:  

1. Link Name - Enter a name for the hyperlink to display on the Folders page.  
2. URL - Enter the URL address (http:// will be prefixed to the address if not entered).  
3. Description - Enter a description of the link. This field is optional.  
4. Location - Confirms where the hyperlink resides and, by default, displays the folder to which 

the Create Link action was applied.  
 

Click OK to complete the creation of the hyperlink, or click Apply to create the link and clear the form 

so that you can create another link. 

After you create the link, the Folders page reflects this new entry. 
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Viewing Details 

Windchill PDM/ProjectLink allows you to view the details of the associated objects to your project. 

Accessing the Details Page 

You can view the details of any object associated with your project, for example, parts or documents.  

 

You can navigate to the details page of a document in two ways:  

 Click adjacent to the document  

 Right Click on the document – View Information 

 

The details for the object are displayed in four tables on the Details page.  

 Details 

 Structure 

 Content 

 Related Objects 

 History 

 Collaboration 
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Displaying Information for Selected Object 

Let's display the details for the selected object, FIRSTROBOTICS WC 10 Quick Start Guide 

document:  

1. Click on the icon  next to the Name of the document for which you want to display details. 
In this example, we want to look at the details for the FIRSTROBOTICS WC 10 Quick Start 
Guide document. The Document Information page appears.  
 

 
 

2. A window displays the six sections of information pertaining to the document's attributes. Keep 

in mind that you can add new sections to this view, by selecting New Tab icon . These 
are explained on the next pages of this tutorial. 
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Details Page - Object Attributes 

The first section on the details page displays object attributes including object location, state, version, 

filename, status and other attributes. State is defined by the workflow assigned to the document by 

routing or by setting it manually.  
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Structure Page  

The Structure tab within the document info page contains tools for displaying and editing the 

document structure. The tab is divided into two sections. The actions toolbar and the document 

structure panes. The areas are described below. 
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Actions Toolbar 

The actions toolbar appears just below the document’s identity and Actions menu. The actions in the 

actions toolbar are divided into sections called action sets. The following table provides an overview of 

the actions available in each actions set.  

 

Action Set Actions 

Editing Includes actions to modify the document structure, including revising, inserting, deleting 
documents, and editing document attributes.  

Check 
Out/In 

Includes Check Out, Check In, and Undo Checkout actions. Use these actions to 
reserve or release the right to modify documents. Also provides the My Checkouts 
action to display documents checked out to you.  

Clipboard Includes Cut and Paste actions that allow you to modify the document structure.  

Viewing Includes actions that allow you to change the information that is displayed in the 
document structure . 

Filter Includes actions allowing you to view and modify configuration specifications used to 
display the document structure.  

Tools Includes actions that allow you to compare structures or open structures in other 
applications such as Product Structure Explorer or Creo View.  

New/Add 
To 

Includes actions that allow you to add selected documents in the structure to baselines 
or packages.  

 

Document Structure Panes 

The area below the actions toolbar on the document information page is divided into panes. Either two 

or three panes appear depending on the Display option you have selected using the right-click actions 

menu. The left-most pane displays the document structure.  

The other panes contain information about the document that is selected in the document structure 

pane. When a different document is selected the information in the other panes will reflect the new 

selection. Information contained in the panes is organized under tabs. The following table describes 

the tabs and the information they contain:  

 

Tab Description 

Attributes Displays important attribute information about the document. . 

Uses Displays the documents that are used by the document selected in the structure pane. In 
a three pane display the Uses tab is in the bottom pane. From this tab, you can perform 
actions such as inserting new and existing documents and modifying attributes on the 
parent/child association between documents.  

 

  

https://firstrobotics.ptc.com/Windchill-WHC/DocMgmtConfigSpecAbout.html#DocMgmtConfigSpecAbout_DocMgmtConfigSpecAbout178_12
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Content Page  

The first section displays the Primary content of the document and the attachments associated to that 

document. Here you can Add/edit/remove/download attachments. 

 

  



    
 
 
 

 P a g e  7 2  

Related Objects Page  

If the document is referenced or references any other objects, or if it is part of a structure, those 
documents and structures will display in this tab in the Where Used, References Documents, 
Referenced By Documents, and Parts tables. 
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History Page  

The second section on the details page displays historical information, including a graphical timeline 

and all previous iterations and revisions of the document appear on this tab in the Timeline and 

Version History tables. This is useful for project participants to view past iterations. As a document is 

checked in and out, its iteration number updates. Each iteration is listed in a new row in the Version 

History table.  

 

Collaboration Page 

On this page you have three sections to help you in the collaboration process of your project. 

The Project Status table is available on the information page of an object that is interoperable The 

table provides information about how an object has been shared, checked out, or copied between 

PDM and a project. The table displays status information about the object for each project to which it 

has been added. Your ability to view that information depends on your individual user access. This 

means that if an object has been checked out to multiple projects, you can only see information about 

versions that exist in contexts to which you have appropriate permissions. 

 

https://firstrobotics.ptc.com/Windchill-WHC/SecurityMgmtPermissionsRef.html
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The Subscriptions table lists existing subscriptions. 

From the Discussions table, you can create, view, and manage discussion topics and postings. 

New Tab (Page)  

By default each information page displays, on one or more tabs, the commonly used information 

associated with the object type. You can customize how your information page tabs display for each 

instance of a specific object type in Windchill in the following ways:  

 Creating, reordering, and removing tabs 

 Adding, removing, and reordering information tables on tabs  

 Restoring default settings 

 
 

Tabs: Creating, Reordering, and Removing 

Each object has one or more tabs available by default. Use the following procedure to create 

additional tabs to meet your needs:  

1. To create a new information page tab, click the new tab icon located to the right of the 
existing tabs.  

2. Once the tab is created, you can rename it by right-clicking the tab name and selecting 
Rename Tab. 

3. If you choose, you can then drag-and-drop your tabs to change their order. 
4. You can remove a tab by either clicking the close icon to the right of the tab name, or by right-

clicking the tab name or selecting Delete Tab.  

Information Tables within Tabs: Adding, Reordering, and Removing 

Depending on the settings your administrator has placed in Windchill, some tabs may be pre-

populated with tables that you cannot add or remove. The tab names for these administrator-defined 

tabs appear in italics. However, tabs that you have created using the preceding procedure are fully 

customizable with regards to adding, removing, and reordering available tables.  

1. To add or remove an information table, open the Customize drop-down menu in the upper 
right corner of a new tab pane. A list of available tables appears, with any currently displayed 
tables already selected. 

Note 

The list of available information tables varies depending upon the object you are viewing and 

your Windchill capabilities. 
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2. Select the checkbox for each table you want to display. Clear the checkbox for each table you 
want to remove. 

3. To reorder tables, drag-and-drop the table name at the top of the tab to the desired order 
(drag-and-drop table names to the right to move the table up, or drag-and-drop the table name 
to the left to move the table down). 

4. Minimize the table by clicking the collapse icon to the left of the table name. Click the 

expand icon to expand the table again. 
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Discussions Page 

Windchill ProjectLink lets you participate in discussion forums that relate to your project. Team 

members can reply to existing postings or start new discussions about a different area within the same 

project. 

1. Click the Discussion option in the Navigator Pane.  

 

2. The Discussions page, allows you to create and view file-specific discussions, and reply and 

subscribe to postings for the project. 
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Creating a Topic 

Now that you have the Project Discussions page displayed, you can create a discussion topic.  

1. Click New Topic icon  to create a topic for the discussion. The New Topic page 
appears.  

2. Type a topic name in the Topic Name field.  
3. Select the Subscribe check box if you want to receive e-mail notifications when postings are 

made to this topic.  

 
 

4. Click OK to complete the topic.  
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Creating a Posting 

Once you have the Project Discussion page displayed, you can create a posting to a topic.  

Let's create a discussion topic and subscribe to it:  

1. Click Create Posting next to the topic to which you want to add a posting. In this case, we 
are adding a posting to the Kick-off Check List topic.  
 

 

2. The Create Posting window displays. In this example, the desired posting information has 
been entered.  

 

The following steps are necessary to create a posting:  

1. Select a topic from the Topic drop-down list. In this case, we selected Kick-off Check List.  
2. Type a subject name in the Subject field. In this case, we typed Meeting Information.  
3. Type your message in the Message box.  
4. Optionally, click Next to add attachments and links. Step 2 Add Attachments gives you the 

option to attach external files that may be valuable to someone reading this posting, but may 
not be required for the overall project. Step 3 Add Links gives you the option to add links to 
Web pages or any other system that can be accessed through a URL.  

5. Click Finish to complete the creation of the posting or Cancel to abandon the creation of the 
discussion posting.  
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Unsubscribing from Discussions 

As we learned previously, when you have subscribed to a discussion forum, you receive e-mail 

notifications each time a new posting is added to the discussion. If you are not interested in receiving 

e-mail notifications, you can unsubscribe from the discussion.  

1. Open the Project Discussions page.  

 
 

2. If desired, click Unsubscribe   to unsubscribe to this posting. 

 

3. You are no longer subscribed to this discussion.  
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Discussing Documents 

Windchill ProjectLink provides a way to create and participate in discussion threads for project files 

such as documents, CAD models, and parts. You create discussion threads and postings, as well as 

subscribe to specific discussion topics through the Discussions section on the Collaboration page of 

the desired file. 

Navigating to the Folders Page 

Because we plan to create a discussion topic and a related posting for a document, you need to 

access the Document Actions section from the Collaboration page. Discussions can be created for 

other object types, such as parts and CAD models.  

1. Click View Information adjacent to the document you want to discuss.  

 

 

2. From the Information page, click the Collaboration tab option and go to the Discussions 
Section.  

 

 

3. The Discussions table, allows you to create and view file-specific discussions, and reply and 
subscribe to postings. 
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Follow the instructions listed for Creating Topics and Creating Postings to create file specific 

discussion details. 

Subscribing 

You can request to be notified of updates to project parts, documents, discussion forums, and plan 

activities in Windchill ProjectLink. 

Navigating to the Create Subscription Page 

1. Select the Actions link or mouse right click for the object to which you want to subscribe 

. In this case, we want to subscribe to a part.  

 

2. Select Subscribe. The Create Subscription window appears. 
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Selecting Events 

To create the subscription, you work in the Select Events wizard. Let's select the events for which you 

want to be notified. There are different events to select from depending on the item you subscribe to.  

1. Select any or all of the following events: Check in, Check out etc.. In this example, we select 
Check in.  

 

2. Click Next. Select the Subscribers, by adding the user to the list.   
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3. Click Next. Define the recipient's email notification with a subject and message that grabs 
attention. 
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4. Click Finish. 
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Routing Documents 

Selecting a Document to Route 

To route a document, either use the Route option using the mouse right click Document Actions pull-

down menu or selecting the Actions link at the document level. 

 

Note: Only users with proper access control authorizations are able to route a document. 

The Route Wizard 

After a document is selected to route, the Route wizard displays the following steps:  

1. Select Routing Process  
2. Define Distribution List  
3. Specify Instructions  
4. Specify Due Date  
5. External Participants 
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By default, there are four available routing processes. If more appear, or they are named differently, 

the Organization Administrator may have made these modifications to adapt to the business needs of 

the users. The flowchart for each of these processes is displayed in the following graphics, to visually 

represent the workflow of a routing: 

Approval Routing 

 

Notify Routing 
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Release Routing 

 

Review Routing 

 

Select one of the above routings to continue on to the next step of the wizard. 

Defining the Distribution List and Specifying Instructions 
Once a route process is chosen, the project team members desired for the particular type of route can 

be selected. Note that some members listed may be roles or groups mapped to multiple users. 

 

Click Next when the members are selected. In the next step (Specify Instructions), you can create a 

customized message to be sent with the e-mail notification automated by the route initiation. 

 Specify Due Date - Specify either the due date or duration for each applicable routing activity (not all 

routing activities include a due date or duration).  

Optionally, you can also select Notify assignee to have an email reminder sent to the routing process 
participants who must complete tasks. Notifications are sent based on the specified number of days 
before the due date.  
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Select Notify routing initiator to have an email sent to you if the routing process tasks have not been 
completed.   
 
External Participants 
If you would like to notify someone not specifically included under the Define Distribution List step, you 
can enter one or more email addresses under this step. An email is sent once the routing process is 
complete.  
 
Click Finish to return to the Folders page. An icon displays to indicate that a route process has been 

applied. You can click this icon for additional information about the route status.  

 

Create a Meeting 

Windchill ProjectLink allows you to conduct meetings with teams and individuals. You can collaborate 

on parts and, or, documents in real-time using the meeting capability. 

Meeting Types 

The main type of meeting is:  

Standard - Traditional meeting with the ability to define a meeting by composing a meeting invitation, 

inviting all desired participants and attaching pertinent project files with optional teleconferencing 

information.  

Set the correct time zone to be displayed when creating a meeting 

You will have to access Quick Links - >My Settings - > Preferences 

 

From the Preferences Page, access Attribute handling->Local time zone and specify the time zone by 

right click to edit. 
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The Set Preference Window will appear and you will have to select the desired time zone for you and 

then click OK. 
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There are five steps to create any meeting type; however, you do not have to complete them all. A 

meeting can be successfully created as long as you define the required fields: Meeting Name; Type; 

Date; and Time. Optionally, you can set meeting duration in minutes.  

a) Click the Meetings button on the Project page to navigate to the project's meetings. If there are 

meetings already set up you will see them by meeting details Name, Date, Time, Host, Status, 

and Type.  

 

b) Click Create Meeting icon . The Create Meeting wizard initiates. You fill in the 

required fields (identified by an asterisk) – Meeting Subject, Date and Time, Duration, Phone 

Number, Location 
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c) Click Next. The Select Participants wizard initiates.  
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Add Participants 

Now you need to add the meeting participants. Participants can be added as individual users (Users), 

or through selection of defined roles (Groups), .  

Let's add participants.  

1. Select Users or Groups from the drop-down menu.  
Users and Groups are identified by e-mail address because that is how they will be notified 
when invited to a meeting.  
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2. Click Search. The system returns all of the individual participants (Users) or defined roles 
(Groups) in your project, from which you select additions to the Meeting Participants list.  

3. Highlight the participants or roles you want to add to the meeting.  
4. Click Add. The selected participants are added to your meeting. The Remove button can be 

used to remove a participant from the list.  
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d) Click Next. The Identify Meeting Objects wizard initiates so you can add related parts and 

documents to your meeting.  
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Add Parts and Documents 

You can add parts and documents that are related to your meeting through the Identify Meeting 

Objects wizard. These parts and documents can be discussed in real-time during the meeting.  

1. Select Parts or Documents from the drop-down list.  

 

 

 

2. Click Search. A list of the entire project's uploaded parts or documents displays.  
3. Highlight the parts or documents you wish to add to the meeting.  

Note: You can use the wildcard characters * and ? to narrow the search, or leave the field 
blank to search for all parts and documents.  
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4. Click Add. The parts or documents display in the Identify Meeting Subject Objects window.  

e) Click Next. The Agenda wizard initiates. Note: Setting an agenda is optional. If you wish, enter 

a brief agenda for the meeting.  

 
 

You may select Finish at any time to complete the meeting creation process or Cancel to end the 

meeting creation process. If you have selected the Finish button an invitation will be sent to the 

participants: 

 

 

Complete Meeting Setup 

When you complete the required and optional steps, you are ready to create the final meeting.  

1. Click OK from the page you are on. The Project page displays and lists the meeting you just 
created, as well as any other meetings related to the project.  
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Edit Meetings 

A Windchill ProjectLink meeting organizer can easily update the meetings they have created. You use 

the Edit Meeting page to change meeting parameters to accommodate the needs of a project team. 

You have to right click on the Meeting that you want to modify.  

 

Parameters that can be changed include the meeting name, schedule, agenda, participants, required 

documents, or telecommunications. 

Accessing the Update Meeting Page 

In this lesson, you learn how to access the Update Meeting page.  

1. From Windchill ProjectLink, click the Project tab.  
2. Click the Meetings page link from the Project bar on the left from the Navigator Ribbon. If 

meetings have not been created, the Meetings page reads "No Items to Display."  
3. Click Actions in the Actions column for the meeting you selected.  

The Meeting Actions pull-down menu window displays.  

 

4. Click Edit Meeting to display the page.  

Updating the Duration of a Meeting 

In this lesson, you access the Update Meeting page and change the meeting duration from zero (0) 

minutes to 60 minutes. 

1. Enter 60 in the Duration (minutes) field to change the meeting duration time. 

 



    
 
 
 

 P a g e  9 8  

 

 

2. Click OK. The Edit Meeting page closes. 

 

After you update the meeting parameters, you can view your changes from the Meetings table on the 

Projects page. 

Installing Windchill CAD Workgroup Managers 

This part of the tutorial demonstrates how to install a Windchill CAD workgroup manager for your CAD 

application. Installing the workgroup manager allows you to upload and download designs to and from 

Windchill solutions using your CAD application. 

Navigate to the Software Downloads Page 

In order to use this integration, you must install a workgroup manager that is compatible with your 

CAD system. In this tutorial, we will download the Workgroup Manager for AutoCAD.  

Workgroup managers can be downloaded from the Software Downloads page in the CAD 

Integrations section.  

1. Make sure your CAD application is not running. If it is running, close it now.  
2. On the QuickLinks tab, click Software Downloads. 
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3. Review the Additional License Agreement Terms, and then click Accept.  
4. On the Software Downloads page, locate the Windchill Workgroup Managers section and 

click the Windchill Workgroup Manager.  

 

5. Click the Start Installation to download the WGM and begin the installation.   

 

 

Install the Workgroup Manager 

Complete the installation as follows:  

1. Once the WGM has been downloaded, the installer should automatically start.  Click OK to 
proceed. 
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2. Before you begin the installation, review the general information in the dialog.  Click Next. 

 

3. Browse or type the default installation directory for the WGM.  Click Next. 
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4. Define the Default Shortcut Folder.  PTC recommends using the default option.  Click Next. 

 

5. Click Install to begin the installation. 
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6. Once it installation is complete click Done. 

 

7. Log off and then log on to your computer to update the CAD application integration. 

Confirm the Installation 

Once the installation process has been completed, you should verify that the workgroup manager was 

installed.  
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1. Open your CAD application.  
2. Confirm that a new Windchill menu has been added for the integration.  

You are now ready to work with the defined CAD tool to store and work on data in your project. 

Launching and Using Creo View 

The Windchill ProjectLink Visualization tool, Creo View, allows users to view data from a variety of 

sources, without requiring access to the application that created the data.  

Using Creo View, you can view and annotate documents, drawings, images, 3D models, and ECAD 

files. You can also measure and analyse 3D data, which can come from variety of different CAD 

systems. This functionality allows users to analyse the product design, annotate files to indicate review 

comments, obtain information about parts of a product structure, and collaborate dynamically with 

others regarding design or document content.  

Launching the Viewer 

From the Information Page for the specific model, you will notice a dynamic preview allow you to 

rotate, spin and zoom the model. 

 

Holding your mouse over the thumbnail, use the following commands to orient the model: 

 Hold the middle mouse button and move the mouse in any direction to fly around the model 

 Roll the middle mouse scroll button to zoom in and out 

 Hold the right mouse button and move the mouse in any direction to rotate the model. 

To open Creo View Express, click on the Preview window.  Creo View Express will be launched. 
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 Click the box beside the top level assembly to show the data file in Creo View. 
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Basic Viewing Features 

We've opened the CAD model in Creo View. Now let's review some of the viewing features available 

in this tool.  

 

Using Creo View, you can measure and analyze 3D data, which can come from variety of different 

CAD systems. You can measure distance or dimensions within the viewer.  

 When viewing 3D data, you can click to select and move components in the view. This is 
called translating the component. You might do this to examine individual components, or to 
temporarily move them out of the way if they are obscuring the view of other components. You 
can also spin or rotate components to view them from different perspectives. To do this, you 
toggle between translation and rotation modes using buttons on the toolbar.  

 You can also show or hide components as needed. If desired, you can change the rendering 
of 3D components to appear as shaded, wireframe, or hidden lines removed.  

 Creo View lets you use the mouse and keyboard to easily navigate in the viewer. There are 
two navigation modes: fly-through and inspection.  

o Fly-through mode allows you to interactively fly around a 3D component to view that 
object from different depths and angles. You can think of this like moving your head, 
where a slide to the left moves the head to the left, with in the object in the view 
moving to the right. You use the middle mouse button (Alt + right mouse button for a 
two-button mouse) to fly.  

o Inspection mode is like holding an object in your hand and viewing it from different 
angles. This mode is the default. You use the right mouse button to spin the viewed 
object.  

 Creo View allows you to view and create annotations for all file types. Annotation toolbar 
commands vary based on the type of file you are viewing. You can use annotation to indicate 
comments for review or collaboration, and to draw shapes in the view to highlight specific 
items as needed. Annotation sets appear along the left side of the Creo View window, either 
as filenames or thumbnails. Click an item in the annotation list to load that annotation set into 
the viewer. When you are finished creating annotations, you can upload the annotation set or 
markup to the server. Note: Creo View provides expanded viewing and annotation capabilities 
for PDF files, allowing you to annotate them and track comments and changes, or reply to 
specific comments.  
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 Creo View also provides powerful tools for measuring dimensions or distance between 3D 
parts. When measurement mode is active, you can hover the mouse over items in the view to 
highlight faces and curves that are available for measurement, then double-click to select a 
component, or single-click to select a surface for measurement. The measurement values 
appear in a callout in the viewer for the item or items you selected.  

For more information and instructions on using Creo View, refer to the Creo View Online Help.  

 About the User Interface 

 Working with Creo View 

 Creating Representations and Save Annotations 

 

Installing Windchill Desktop Integration 

This part of the tutorial demonstrates how to install the Windchill Desktop Integration to access your 

Windchill project from Windows Explorer. Installing Windchill Desktop Integration allows you to upload 

and download documents to and from Windchill using your Windows Explorer. 

Navigate to the Software Downloads Page 

In order to use this integration, you must install a Windchill Desktop Integration plugin that is 

compatible with your OS system version 32 or 64 bit. In this part of the tutorial, we will download the 

Windchill Desktop Integration for a 64 OS bit System, Windows 7.  

1. On the Quick Links tab, click Software Downloads. 

 

2. Review the Additional License Agreement Terms, and then click Accept.  
 

3. On the Software Downloads page, locate the Windchill Setup and Installation section and 
click the Windchill Desktop Integration or Windchill Desktop Integration 64 bit.  

https://firstrobotics.ptc.com/Windchill-WHC/index.jspx?id=SubscribeTableRef387&action=show
https://firstrobotics.ptc.com/Windchill-WHC/index.jspx?id=SubscribeTableRef387&action=show
https://firstrobotics.ptc.com/Windchill-WHC/index.jspx?id=SubscribeTableRef387&action=show
https://firstrobotics.ptc.com/Windchill-WHC/index.jspx?id=SubscribeTableRef387&action=show
https://firstrobotics.ptc.com/Windchill-WHC/index.jspx?id=SubscribeTableRef387&action=show
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4. Click on the desired version and then Start Installation to download the WGM and begin the 
installation.   

 

 

Install the Windchill Desktop Integration 64 bit 

Complete the installation as follows:  

5. Once the WGM has been downloaded, the installer should automatically start.  Click OK to 
proceed. 

 

6. Before you begin the installation, review the general information in the dialog.  Click Next and 
Accept the agreement. 



    
 
 
 

 P a g e  1 0 8  

 

 

 

7. Select the option Complete.  Click Next. 
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8. Click Install 

 

9. After the Installation has completed, go to My Computer and look for the Windchill Documents 

System Folder icon and then start to configure the access to the 
FIRST Windchill Server. 
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10. Double click on the Windchill Documents icon and then perform Right click action with your 
mouse button and select Windchill->Configuration. 

 

11. Complete the Server Base URL Area with  https://firstrobotics.ptc.com/Windchill/ and the 
Alias area with FIRST Windchill and then click the Add button. 
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12. After those two areas have been completed click on the OK button. 

 

13. Then you will notice that a new icon has appeared with the name as the Alias defined in the 

step before.  
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14. Right click on the FIRST Windchill icon and select the Connect option. 

 

 

 

15. A window will pop-up asking you for your Windchill user credentials. Enter your Windchill 

username and password and you will be able to access your Windchill projects from Windows 

Explorer. 

 
 

16. If the connection is successful the icon will change her color. Then double click on the FIRST 

Windchill icon and you will access Windchill through Windows Explorer. 
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Installing PTC Plug-in for Microsoft Project 

 

This part of the tutorial demonstrates how to install the PTC Plug-in for Microsoft Project. 

Windchill ProjectLink supports an optional Microsoft Project plug-in component to support seamless 

exchange of plan information, such as tasks and resources with Microsoft Project 2003, 2007 and 

2010. Project or program members with permissions to create and edit plan objects can import and 

export plans between Microsoft Project and Windchill. They can also edit plan information within 

Microsoft Project and then save it to Windchill. 

With the plug-in installed you can choose Save to PTC from the File menu in Microsoft Project. The 

plug-in also facilitates exporting and editing Windchill plan information by opening the plan directly in 

Microsoft Project. 

 Navigate to the Software Downloads Page 

In order to use this integration, you must install a PTC Plug-in for Microsoft Project plugin.   

Workgroup managers can be downloaded from the Software Downloads page in the Setup and 

Installation section.  

1. On the Quick Links tab, click Software Downloads. 

 

2. Review the Additional License Agreement Terms, and then click Accept.  
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3. On the Software Downloads page, locate the Project Management section and click the 

PTC Plug-in for Microsoft Project.  

 

4. Then click on the Run or Save button. 

 

5. Click on the Next button to continue with the installation. 
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6. Select the installation folder for the plug-in or click on the Next button to continue with the 

default installation. 

 

7. To Confirm the installation click Next 

 



    
 
 
 

 P a g e  1 1 6  

 

8. If the installation was successful you window will be similar to the one below. Click on the 

Close button to exit. 

 

 


